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What are Catz® ?

Catz® are virtual Petz™ that live on your computer. Catz scamper across your
desktop, play in their home Playscenes, travel and explore faraway Playscenes
and frolic in Playscenes that you make especially for them. Breed them, play
with them, feed them, and love them! You can adopt as many Catz as you
want – as long as you take care of them all!

Catz are little when you first adopt them and then they grow up over time 
into adult Catz!

Check out  www. Petz.com for the latest Petz info!!
And, don’t forget, if you get Dogz® 5 too, your Catz and Dogz can play together!!
More breedz, more toyz, more fun!
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Whiskers for twitching.

Alert, expressive eyes.

Soft fur for warmth 
and petting.

Agile paws for jumping, 
climbing, stalking and running.

Tail for balance.
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Getting Started
Catz 5 comes with 15 breedz of Catz. Different breedz have different personalities,
but every Catz is unique! Every Catz has their individual likes and dislikes.

Left-click with your mouse and hold the button
down to pet Catz and pickup Toyz. Right-click and
hold the button down over a Catz to pick them up
and carry them. Double-left-click to call your Catz
over to you.

Left-click on the “Pick a Pet” button on the Adoption
Centre to see all the different breedz of Catz.
Once you find that special Catz, you can adopt it by
clicking on “Adopt Now”. Use your Carrying Case to
“Go To” the Playscenes, “Pick” which of your Catz you
want to come out and play, take pictures of them and view their Petz Profiles.
Put your Petz in front of the Petz door to put them away.
Remember to only adopt as many Catz as you can care for
…neglected Catz will run away.

Catz Care

Catz need love and attention, water, food, and regular
brushing. When your Catz get sick, add Medicine to
their food or water.

Necessities

Water Food Medicine
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Catz also need regular play and exercise – especially if they eat too much.
Catz can become overweight.

And, don’t forget to give them tasty Treatz when they’ve been good and to
discourage naughty behaviour with a squirt from the Squirt Bottle. You can hold
Treatz above, below or to the sides of your Petz and give your hand cursor a
little wiggle. Your cursor will give a little whistle and a hand gesture if you did it
right and your Petz will try to do a trick. Repeated rewarding of tricks you like
will train your Petz to do them. 

Play with Your Catz
Your Carrying Case comes with an initial
assortment of Toyz and supplies for your Catz
to get you started.

As you “Go To” different Playscenes, you
will find more Toyz! When you place these
items into your Carrying Case, you can
then take them anywhere and always have
as many as you want! 

You can get even more Toyz and items when you win at the Mini Games!! There
are over 100 Toyz to find and win. Balls, Bonez, Stuffed Parrots, Airplanes,
Chew Toyz, Pillows to relax on – Not to mention all the collectables from their
travels – Exotic Jewels and Carpets, Doubloons, a Flea Circus and more.
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Fishy Treatz Squirt Bottle

Toyz

Scarecrow Doll Catnip Magic Box
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Dress your Catz in stylish clothing and accessories.
In the Salon, you will find a wardrobe full of clothes and
accessories. Left click on an item you want and drag it
from the closet. You can also drag the clothing on and off
your Petz, but only when you’re here in the Salon. If you
put paint on your Catz or the mice and want to remove it,
you can give them a bath!

Mini Games

Clothing and Accessories

Soapy Sponge

Now you can learn the
ancient art of agility from
Monkey, the Dojo in the
Asian Temple. If you train
hard to learn his teachings,
he’ll reward you!

In the Wild West, a Prairie
Dog has moved-in and he’s
challenging you and your Petz
to a game of Tic-Tac-Toe!
Claim your squares by
dropping your Catz onto
them when it’s your turn.

Mr. Bonez loves music and
wants your Catz to help him
compose. Get your Catz to
touch the coloured tiles in
the order they light up to
receive thank you gifts
from Mr. Bonez!
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Can you keep your Catz happy? When you feed and play with a Catz regularly,
take him or her to their favourite Playscenes and treat them well,
you’ll earn a Happy Pet certificate that you can print
as proof of your fabulous pet care talents!

Playscenes
With Catz 5, your Catz can frolic in their home
Playscenes such as the Kitchen, Backyard and Salon –
or they can travel to the Adventure Playscenes. Go
sledging in a Canadian Snow Scene, do tricks under
the Big Top in the European Circus Scene, play
against a Prairie Dog in the spooky Wild West ghost
town, catch Scarab Beetles in an Arabian palace, and
discover pirate treasure on a South Sea Island. 

Each Playscene comes with its own Toyz – some
Playscenes have Toyz for you to discover when you
return again or stay longer. 

Host Characters – Find out who your Catz will meet on
their travels. Each of the 5 travel scenes have a Catz
host with whom your Catz can play. These Hosts live
in the environment and love having guests over!
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A silly Cobra and his hoard of Scarab
Beetles have infested Arabia! Can you and
your Catz catch them all and bring peace to
the oasis?

The Magic Book in the Fantasy Castle loves
a good game of Rock-Paper-Scissors
against the Suit of Armour, but he needs
your help to decide between the choices.
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Create Your Own Playscenes
You can create your own Playscenes for
your Catz!! Go to “Editor” on the “Go To”
menu and follow the step-by-step
Playscene Wizard. If you are confused,
click on the “Help” menu bar item.
Have Fun!! Create!! Take pictures of your
home and other favourite places with a
digital camera and use that bmp or jpeg
for your Playscene background! 

Or take pictures and scan them into your computer – or create your own picture
using your favourite paint program!

Create Your Own Carrying Case
Now you can customize the look of your Carrying
Case! Inside your Petz 5 folder on your hard drive is
the “Skinz” folder. Within is a template that you can
modify with the paint program of your choice. 
Simply keep your art for the buttons restricted
to the sizes in the template and everything
positioned on the template where you found it. 
Petz 5 will need your Skinz files to be 24-bit .bmp’s. (More detailed information
is available in the “Skinz Instructions” document included in the Skinz folder.)
You can create new art for all three states of the Carrying Case as well as for
the buttons. However, you cannot change the art of the red door that your Catz
come in and out of.
You can change between various Skins using the File menu. 
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Catz Families
Your Catz can have Kittenz! You need to have a
female Catz and a male Catz that are “in love”.
You’ll know when your Catz are in love when they
groom each other, follow each other around and
bring each other Toyz and treatz. You can set the
mood and help Catz fall in love with special
Aphrodisiacs such as the Heart Pillow, the Perfume,
the Love Potion, the Music Box and the Heart Candy. 

Go to the Petz Profile by clicking on the pink or
blue Catz icon on the Carrying Case. Here you can view
the statistics of your Catz and see up to 8 generations of your Catz’ Family Tree.

www.Petz.com
The Petz Web Site at www.petz.com is a great place to visit and learn all
about Catz and Dogz. This is the place where you’ll be the first to find out
about awesome new Petz products, accessories, and the latest news. And, with
the Petz Player (automatically installed with Catz 5 and Dogz 5), you can play
with your Petz and other owners' Petz on fan websites!
Check www.petz.com often for all the latest information on the Petz!

The Petz Publisher Wizard walks you through creating your own Web page.
Choose from many templates, some of which let you share a “live” version of
your Catz online with others! See “Petz Player” below for more information.
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Petz Profile
Perfume Music Box

Petz Publisher
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The Petz Web Fun Pack is chalk full of Petz clip art, animations,
backgrounds and more!

With the Petz Player you can play with your Catz and other Catz online. Catz 5
automatically installs the Petz Player to your computer. Go to www.petz.com

to play with some Petz online or you can create your own web page using the
“Live” templates in the Petz Publisher.

Tips!

In the General Options menu, you can adjust the frequency of
the Night Cycle. Setting it faster than real-time does NOT mean
your Kittenz will grow faster. 

Each day you run the Petz program, your Petz will grow a bit (until it reaches
full size). However, if you leave your program running over night, this will not
automatically happen. You must re-start the game each day. 

Kittenz become Adult Catz in approximately 3 to 4 days. Catz do not get old or
die. When your Catz have a litter, Newborns become Infants in
2 to 3 days. Newborns become Kittenz in 7 days.
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Petz Web Fun Pack

Petz Player

Carousel

Day Night Cycles

How Petz Grow

Cat Night Light

04430 CATZ 5 MANUAL UK/PC  15/10/02  4:09 pm  Page 9



When you cheat with your computer’s calendar to speed up the birth of your
Kittenz, the mother will become stuck in her pregnancy status. If this happens,
there is no way to fix it! Be patient, don’t do it!!

Now you can bring all the Toyz and objects you find in Catz 5 with you
everywhere you go! When you find a new Toyz or win one in a Mini Game, simply
drag it to the Toyz Shelves to keep it with you anywhere you go. 

If you have Catz on your computer from earlier versions,
you can import them into Catz 5 through the “File” menu. 

Now if any of your Catz runaway, they may be found and turned-in to the
Adoption Centre! Check the Message Board next to the building for any notes
that your Catz was found. If your Catz runs away, you will only get one more
chance to be a good Catz owner to him/her. Your Catz depend on you for their
care and happiness! 

Some fans modify the files in the game and offer them for
downloading on their fan sites. We think this is cool! In fact,
we’re flattered. But since Ubi Soft did not create this content,
installing any modified files not from Ubi Soft breeches our
warranty and support policies. In other words, if it breaks the
game, we cannot help you fix it.
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Stuck Pregnancies

Importing Petz

Toyz

Runaways

Hexies

Unicorn Plush Toy

Spider Cookie Treatz
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UBI SOFT UK

TECHNICAL SUPPORT
Please be as specific as you can be about the problem that you are experiencing
and have the following details available:

• The product you are experiencing a problem with.
• The name of the manufacturer of your computer system
• The brand and speed of the processor
• How much RAM you have
• The version number of windows you are using (if you aren’t sure, right-click

on the my computer icon on your desktop and select ‘properties’)
• The manufacturer name and model number of your video card, modem, and

sound card.

Support Options
You can contact Ubi Soft Technical Support by phone. When you call, please
have all of the above mentioned information ready.

Ubi Soft Technical Support: 0870 739 7670
Hours: Monday To Friday 8.00am – 11.00pm GMT 
Ubi Soft Hintline: 0906 906 0200

Call Charged will be made at £1.50 per minute.
Calls length will vary but usually lasts 3 to 4 minutes.
Please ask the Bill payers permission before using this number.

On-line Support Options
Ubi Soft offers on-line support options for software products. One of these is
our website at: http://www.ubisoft.co.uk/support/.
If you have a specific problem that is not addressed on our site or has not been
rectified by our first stage support, you can send your question to us via e-mail
at: techsupport@ubisoft.co.uk.

Mailing Address: Ubi Soft Entertainment Ltd. 
Chantrey Court,
Minorca Road,
Weybridge,
SURREY. KT13 8DU.
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UK Warranty
Ubi Soft guarantees to the original buyer of the product that the compact disc
(CD) supplied with this product shall not show any fault during a normal-use
period of ninety (90) days from the invoiced date of purchase.

Please return any defective product to; Ubi Soft Entertainment Ltd., Chantrey
Court, Minorca Road, Weybridge, Surrey, KT13 8DU together with this manual
and your registration card if you have not already sent it to us. Please state
your full name and address (including postcode), as well as the date and location
of purchase. You may also exchange the product at the place of purchase.

If a disc is returned without proof of purchase or after the warranty period
has expired, Ubi Soft will choose either to repair or to replace it at customer
expense. This warranty is invalid if the disc has been damaged through
negligence, accident or misuse, or if it has been modified after acquisition.

This software program, manual and packaging are protected by copyright and all
rights are reserved by Ubi Soft. Documentation should not be copied,
reproduced, translated or transferred, in whole or in part and in whatever form,
without prior written agreement of Ubi Soft.

This software program, this CD and its documentation are sold as they stand.
Outside the guarantee period of 90 days concerning any manufacturing defect
of the CD, Ubi Soft will not extend any other guarantee concerning this
program, this CD nor its documentation, be it written or verbal, direct or
implied, including but without limitation of the above, guarantee and conditions
of marketing and use for specific purposes even though the company may have
been informed of such use. Similarly, you shall be entirely responsible for any
risks relative to utilisation, results and performance of this software program,
of this CD and the documentation. Ubi Soft shall in no event be liable to you or
a third party for indirect or consecutive damages, nor specific damages relative
to ownership, the use or the wrongful use of this product and, within the limits
provided by law, damages in case of bodily injury, even if Ubi Soft has been
informed of such possible damages or losses. The buyer wholly accepts that, in
case of legal claim (contract, prejudice, or other) the liability of Ubi Soft shall
not exceed the price value originally paid for the purchase of the product.
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NOTES
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